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Introduction 

This standards manual is a guide for consultants developing specifications for the Port of Portland.  
Guidelines and examples presented in this standards manual will help consultants produce specifications 
that are consistent with the Port’s format, appearance, and professional standard. 

These are only guidelines.  If common sense and job applicability suggest the need to consider 
appropriate alternatives, discuss the options with appropriate Port contacts; however, deviations from the 
guidelines require Port approval. 

This standards manual should not be considered a substitute for good communication between the team 
members involved.  Effective communication between the consultant’s staff and the Port’s engineering 
project manager, project engineer, and specification (spec) writer will help ensure production of concise, 
accurate, and complete specifications – on schedule. 

Prior to initiating any specification production work, the engineering project manager or project engineer 
will usually schedule a meeting with the consultant’s team to discuss the specifics of the project.  At this 
meeting, the Port spec writer will provide information on how the project manual’s specifications should 
be created. 

The goal of the Port/consultant team is to provide the desired product within scope, schedule, and budget.  
Consequently, the consultant is always encouraged to contact the project engineer or spec writer when 
any question arises, or when any clarification or direction is needed, no matter how small the issue. 

Port Specifications Contacts 

Colin Doherty 
(503) 415-6366 
colin.doherty@portofportland.com 
 
Etta Goerl 
(503) 415-6718 
etta.goerl@portofportland.com 
 

 

 



Specifications Standards 

 1 

Overview 

Construction projects are printed and bid through the Port.  The consultant works with the Port project 
engineer and spec writer to develop the project specifications.  The Port’s specification format follows the 
Construction Specification Institute’s (CSI) 2010 Masterformat guidelines for organizing and numbering 
sections and divisions.  Generally, the Port provides the “front end” documents and Division 1 sections 
that relate to Port facilities and administrative requirements.  The consultant provides information for 
Section 012200, including unit pricing and work descriptions, as well as any other Division 1 sections of 
a technical nature.  The consultant also provides the technical sections in Division 2 and beyond. 

Port-Generated Documents 

Front-end documents, prepared by the Port, include the following elements: 

• Cover 
• Approvals Page 
• Table of Contents 
• Drawings Index 
• Invitation to Bid 
• Instructions to Bidders 
• Supplementary Instructions to Bidders 
• Substitution Request Form 
• Bid Form 
• Bid Supplements 
• Agreement 
• Performance Bond 
• Labor and Material Payment Bond 
• General Conditions 
• Supplementary Conditions 
• Wage Rates 

The consultant is encouraged to ask the Port spec writer for a sample project manual and/or a copy of the 
Port’s Instructions to Bidders and General Conditions.  The Instructions to Bidders and General 
Conditions are usually standard from project to project.  It is important for the consultant to become 
familiar with them to prevent duplication or conflicts with statements in the technical sections.  Consult 
with the Port project engineer and spec writer if a project requires deviation from the Port’s standard 
front-end documents. 

Division 1 

The following Division 1 sections are typically included in most projects and are prepared by the Port: 

• Section 011100, Summary of Work 
• Section 013100, Project Management and Coordination 
• Section 013300, Submittal Procedures 
• Section 013513, Airport Security, Safety, and Operating Regulations (if appropriate) 
• Section 014500, Quality Control 
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• Section 015000, Temporary Facilities and Controls 
• Section 015719, Environmental Construction Controls 
• Section 017000, Execution Requirements 
• Section 017419, Construction Waste Recycling (if appropriate) 
• Section 017700, Contract Closeout 

The following Division 1 sections are prepared by the consultant, as applicable to the project: 

• Section 012200, Unit Prices 
• Section 015600, Temporary Construction Walls 
• Section 015639, Tree and Plant Protection 
• Section 015713, Temporary Erosion, Sediment, and Pollution Control 
• Section 017329, Cutting and Patching 
• Section 019100, General Commissioning Requirements (if appropriate) 

Technical Divisions 

Divisions 2 and beyond are prepared by the consultant.  For many sections, particularly civil, mechanical, 
and electrical sections, the Port has office masters available (see Port-Provided Specifications section 
below).  The consultant is expected to rework these sections to fit the current project.  Do not insert them 
into the project unedited.   

When writing the technical sections, the consultant should avoid repeating, or conflicting with, general 
provisions normally included in Division 1 or other front-end documents.  The consultant is also 
encouraged to avoid cross-referencing between these sections and the technical sections, because their 
relationship to all of the contract documents is already established. 

Port-Provided Specifications 

Downloadable Port Office Masters 

The consultant should work from Port office masters whenever possible.  Most of these are available for 
download on the Port’s public website at www.portofportland.com.  From the Port’s home page, select 
the Business Opportunities tab.  Then select Master Specifications and Standard Details.  A list of 
sections and links to the documents will be shown.   

Working With Port Office Masters 

Port office masters are Microsoft Word documents and were created using MasterSpec’s MasterWorks 
template.  Master file names end with the letters, “____MT.DOC.”  The Port’s office masters have 
general editorial notes contained in yellow shaded boxes, which are intended to help guide the user 
through choices to be resolved as the section is developed.  These notes, while helpful in editing the 
section, are not meant to be part of the final document, and should be deleted before the completed 
document is returned to the Port.   

Some Port office masters also have notes directed to architects and engineers who perform design work 
for tenants of Portland International Airport.  These notes should be disregarded and deleted by 
consultants employed by the Port to work on Port projects (including PDX).   
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The Port uses the MasterWorks template from MasterSpec to format its office masters.  The “style” 
associated with each paragraph sets the font, indentation, and number or letter that precedes the text.  To 
view the styles in a Port document: 

MS Word 2007 and 2010:  Click on the Office Button>Word Options>Advanced, scroll down to 
Display, and in the Style area pane width in Draft and Outline views field, insert “0.7.”  To assign a 
different style, click on the Home tab, then go to the Styles pane, click on the drop-down box below 
Change Styles to show the Styles window, and select a style as appropriate.  

MS Word 1997-2003:  Go to Normal View, click on Tools>Options>View, and increase the Style 
area width to 0.7 inches.  To assign a different style, activate the Formatting toolbar (click on 
View>Toolbars>Formatting), then click on the style drop down window in the toolbar to select the 
appropriate style.   

Selecting a style and applying it to a paragraph in this way will preserve the automatic numbering feature 
in Port office masters.  Deleting the paragraph symbol at the end of a paragraph may alter the style of that 
paragraph or of a nearby paragraph. 

Never assume that a Port master is a complete document without need for modification.  Consultants are 
expected to actively evaluate the Port’s office masters in relation to their project’s focus, and make 
modifications, additions, and deletions to the document, as necessary.   

If the consultant notices an outdated reference standard or other significant error in a Port master, please 
inform the Port project engineer and spec writer of the necessary correction. 

FAA Specifications 

Projects funded in whole or in part by the FAA are required to use the latest FAA master 
specifications, which are available for download from the FAA’s website.  Prior to working on FAA 
specifications, the consultant shall download the Port’s Modification of Airport Design Standards 
form for each section that will be included, as well as all applicable FAA Northwest Mountain 
regional modifications.  The Port’s public website contains downloadable Port modifications and a 
link to the FAA Northwest Mountain Region website. 

When preparing FAA sections for in-house review, the consultant shall incorporate the Port’s and 
FAA regional modifications using Track Changes in MS Word so that all modifications are shown.  
Changes other than those indicated in the Port’s Modification of Airport Design Standards or in the 
FAA Northwest Mountain Region Modifications should be kept to a minimum and discussed with the 
Port project engineer prior to implementing.  Each change to the FAA’s specifications requires 
discussion with the Port’s project engineer and proper documentation on the FAA-provided form.   

Track Changes should not be used when deleting FAA editor’s notes (the FAA does not require these 
types of changes to be indicated).  Main article numbers and headings should also remain intact 
unless the FAA editor’s notes direct otherwise.  If a particular article is not used, delete the text and 
replace with “Not used.”  New topics/paragraphs should be added at the end of the appropriate section 
so that the basic FAA numbering scheme is not compromised.  If adding text at the end of the section 
seems inappropriate for the topic, add the new text under a subordinate heading or number in the 
appropriate place.  After final Port review, accept all changes and remove edit marks for 
advertisement. 

Note that these requirements pertain only to FAA sections and not to other Port master sections.  
Contact the Port spec writer for additional information on specification procedures and requirements 
for FAA-funded projects.   
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Working with Non-Master Specifications 

If Port office masters are not available, the consultant should contact the Port spec writer to discuss other 
options for creating the sections needed.  The Port spec writer may recommend looking for sections from 
past Port projects that can be used as a starting point by the consultant.  However, since these sections 
originate from various sources, they do not have editorial notes and may not always observe all the Port 
formatting and specification writing standards.  They may also contain outdated reference standards, 
inaccurate cross-references, outdated section numbers, or unique perspectives that were applicable to very 
different circumstances.  Another option the Port spec writer may suggest is to look for the requested 
sections in the Port’s commercial specification library, Masterspec.   

If the Port spec writer is unable to find a requested section, the consultant will be instructed to supply his 
own section, edited and formatted in accordance with Port standards.  Whatever the origin, the consultant 
is expected to carefully edit every section specifically for the current project. 

Specification Format and Content 

With the exception of FAA sections, the Port uses CSI’s numbering and formatting guidelines for 
organizing specifications.  The Port primarily uses performance-based specifications, and directs the 
language only to the contractor rather than to the supplier or subcontractor. 

What follows is a brief summary of how the Port’s specifications are composed and formatted.  There is 
also a sample specification page at the end of this chapter. 

Divisions 

According to CSI, there are currently 49 divisions (see CSI’s Masterformat 2010 publication for more 
information).  For Port projects, include only those divisions for which there is work in the project. 

Sections 

Each division has one or more sections.  Include only those sections necessary to the project.   

Section Numbers and Titles 

The Port’s office masters follow the six-digit section numbering scheme prescribed by CSI’s 
Masterformat.  Whenever the consultant develops a section that is not a Port office master, he should 
coordinate with the Port spec writer to determine an appropriate section number and title.  Generally, 
the Port prefers section numbers that fit within the broader categories of Masterformat; narrowscope 
numbers with a trailing decimal and additional digits are not used.  Occasionally, Port spec writers 
may deviate slightly from Masterformat and assign a section number that better fits into the Port’s 
existing database. 

Parts 

Sections are divided into three parts, as follows: 

Part 1 – General:  contains statements which pertain to the work of that section only.  Do not 
confuse these statements with the statements in the bid documents, General Conditions, or 
Division 1.  For example, “Warranty” in Part 1 of a technical specification would specify a 
warranty period that is beyond the standard one-year warranty period covered in the Port’s 
standard General Conditions.  Likewise, “Submittals” specified in Part 1 of a technical section 
would contain more specific section-related requirements that build on (but do not conflict with) 
the requirements of Section 013300, Submittal Procedures, in Division 1.  Do not repeat 
generalized criteria that are already specified elsewhere. 
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Part 2 – Products:  contains product specifications for the work of that section only.  Remember 
that Port specifications are primarily performance-oriented.  Name-brand products or 
manufacturers need to include either “or equal” or the term, “pre-bid approved equal.”  Both of 
these terms are defined in the Port’s General Conditions.  Either term is acceptable, and it is at the 
discretion of the consultant to determine which makes the most sense on a case-by-case basis.  
Substitute products for a “pre-bid approved equal” item must be approved (often by the 
consultant) and communicated to bidders by addendum prior to the bid opening.   

Products listed in the Port’s office masters which are followed by the term “no substitution” have 
been specifically exempted and approved by the Port’s Contracts and Procurement Department as 
sole-source products.  Do not use this term for other products unless directed to do so by the Port. 

General guidelines for determining when to use “pre-bid approved equal” versus “or equal” are as 
follows: 

Use “Pre-Bid Approved Equal” When: 
• Item is significant in terms of cost or quantity and there is significant risk of skewed bid 

results. 
• Item is a key component of a new system or needs to be compatible with an existing 

system and has an important function or feature that is not included in all substitute 
products.   

• There is a high probability that some substitute products proposed for an item may be 
perceived by bidders as equals when in fact these products are not truly equal and would 
not be accepted as such.  

Use “Or Equal” When: 
• There is a desire to retain maximum flexibility in terms of reviewing and accepting 

proposed substitutions. 
• Risk is low in terms of cost and potential for skewed bid results.  An example of this 

would be an item with many known substitutes that are interchangeable and frequently 
accepted as equals. 

Part 3 – Execution:  contains instructions to the contractor for performing the work of that section 
only.  Do not direct instructions to a subcontractor.  All Port specifications are written as if they 
were being read by the prime contractor only. 

Articles 
Each part is divided into one or more articles, for example:  1.1 is the first article in Part 1, 2.3 is the 
third article in Part 2, and so on.  Each article has a capitalized side heading, such as: 

1.1 DESCRIPTION 
2.3 GROUT 
3.4 GROUT APPLICATION 

Paragraphs 
An article has one or more paragraphs.  The Port uses the following format for all paragraphs: 

A. 
1. 

a. 
1) 
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Font 

Port specifications are written in Times New Roman font.  Do not use bolding, italics, or underlining.  
Font size shall be 11 point for headings and body text.  Font size for footers shall be as indicated 
below. 

Headers and Footers 

The Port does not use headers in its documents.  Sections submitted with headers will be returned to 
the consultant for correction. 

Footers should not be modified in Port office masters unless an exception is allowed by the Port spec 
writer.  For new sections that must be developed in the absence of a Port master, copy the footer from 
a Port master and paste it into the new document.  Revise the section title and number as appropriate, 
but leave the date and directory path fields unedited.  Also ensure that footers are set up for odd/even 
pages and do not exceed two lines, and that the font is uppercase and sized appropriately (see 
example below). 

Odd page: 

DATE (xx/xx/xx - 8 pt font) (9 pt font) SECTION TITLE 

DIRECTORY PATH (8 pt font) (9 pt font) SECTION NUMBER-PAGE NUMBER 

Even page: 

SECTION TITLE (9 pt font) (xx/xx/xx - 8 pt font) DATE 

SECTION NUMBER-PAGE NUMBER (9 pt font) (8 pt font) DIRECTORY PATH 

Project Phase Deliverables and Requirements 

Design Phase 

As early in the design process as possible, the consultant shall submit a list of proposed technical 
sections to be used on the project.  The Port spec writer will then provide the consultant with a list of 
standards referenced in the Port master specifications to be used on the project.  Before the in-house 
review phase, ideally at 60 percent design, read through the Port master specifications to be used and 
verify the accuracy and date of each referenced standard.  Discuss the findings with the project 
engineer. 

No less than 14 days prior to the in-house review date or earlier if possible, the consultant shall 
submit samples of any non-master sections originated by the consultant.  If multiple consultants are 
contributing specifications, the consultant shall submit sample sections of non-Port office masters 
from each.  The Port spec writer will review the sections and mark the types of modifications the 
consultant(s) must make to bring the specifications in-line with Port standards. 

In-House Review Phase 

The consultant is expected to submit one PDF of all the technical sections prior to the in-house review 
date, free of notes and tracked changes and ready for reproduction.  If requested, the consultant shall 
also submit MS Word files.  Because this is the only time many of the Port reviewers will see them, 
the specifications must be 100 percent complete at this point.  Do not insert sections or language 
intended to be replaced or reworked at a later date.  If the specifications are incomplete (and this 
includes “placeholder” specifications that were originally written for another project and have not yet 
been edited for the current project), they will be returned, unaccepted, to the consultant.  The 
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consultant must notify the engineering project manager or project engineer if he cannot meet the in-
house review deadline with completed specifications. 

Review specifications are printed and distributed by the Port.  They typically do not include 
standardized elements of the front-end documents, such as Instructions to Bidders, General 
Conditions, and Wage Rates.  If not previously obtained, the consultant should request samples of 
these documents from the Port project engineer or spec writer. 

During the review period, the specifications will be reviewed and changes marked.  After the review, 
the project engineer will compile comments and relay them to the consultant.  The consultant shall 
make edits and return the finalized sections to the Port spec writer.  Do not count on addenda to make 
post-review “cleanups.”  The Port will make only substantive changes by addendum.  It is 
unacceptable to use addenda to “finish” the specifications and/or drawings.  Communicate with the 
engineering project manager or project engineer if there is a problem meeting the deadline. 

Prior to the project’s advertisement date, the consultant shall submit the following:   

• Separate MS Word files of all the finalized sections and one PDF containing all the sections.  

• A final table of contents in MS Word. 

• An estimate of bid item quantities and prices (not required if project is lump sum). 

• Stamped/signed approvals page.   

Advertisement and Addenda Phase 

The Port will assemble, print, and distribute the bid documents.  The consultant may be asked to 
provide a list of prospective bidders.   

The Port spec writer will draft and publish addenda based on content provided by the consultant.  
This content is typically submitted to the Port spec writer in electronic format, and should include text 
of the revisions and any documents that will be added or replaced.  The consultant may also be asked 
to evaluate “pre-bid approved equal” substitution requests during this period. 

As-Bid Phase 

The Port spec writer will incorporate addenda revisions, if any, into the electronic specification 
sections sent by the consultant.  Revised sections will be reprinted and integrated into the project 
manual to replace the original sections.  The Port will also print and distribute the as-bid project 
manuals. 

Port Style Guidelines 

• Refer to “the Port,” not “the Owner,” “the Architect,” “the Engineer,” or “the Consultant.” 
• Refer to “drawings,” not “plans.”  Do not capitalize the word. 
• Use initial capitalization for the Port and the Contractor only.  Leave all other nouns lower case. 
• Write to the prime contractor only; do not direct language to subcontractors. 
• Avoid redundancy.  Say once in the most fitting place. This includes repeating information from the 

specifications in the drawings. 
• Leave out divisions not used (i.e., do not put a division heading in and write, “not used”). 



Specifications Standards 

 8 

• Use active rather than passive voice.  For example, say “Apply contact herbicide…” rather than 
“Contact herbicide shall be applied…” 

• Use “The Contractor shall” and “The Port will” rather than “should” or “must.” 
• To fulfill the Port’s public agency responsibilities, follow any listing of particular products or 

manufacturers with either “or equal” or “or pre-bid approved equal” unless otherwise directed by the 
engineering project manager or project engineer. 

• Use the word “submit” when referring to items that the contractor must deliver to the Port (such as 
operation and maintenance manuals, weight tickets, etc.). 

• Omit cross-references to documents such as the General Conditions, Section 013300, or other 
divisions or sections which apply to the work in a general sense.  Cross-reference only the technical 
sections that are dependent or uniquely related to the work of another section.  (And please verify that 
cross-referenced sections do exist in the project manual and that their numbers and titles are correct.) 

• Use numerals for technical numbers, and spell out units and abbreviations (i.e., “18 inches on 
center”).  Do not repeat numbers using an alternate format (i.e., “two (2) weeks”). 

• Use normal fractions and not fraction characters (i.e., “1/2,” not “½”). 



 

SECTION 210519 - GAUGES FOR FIRE SUPPRESSION SYSTEMS 

PART 1 - GENERAL 

1.1 DESCRIPTION 

A. This section describes pressure gauges. 

1.2 REFERENCED STANDARDS 

A. AWWA:  American Water Works Association 

1.3 SUBMITTALS 

A. For each item specified herein, submit product/material data; shop drawings; operation and 
maintenance data; as-constructed data; operation and maintenance manuals; and as-constructed 
drawings. 

Use B only if Commissioning Section 019100 is included in the project manual. 

B. For each item specified herein, submit commissioning plans and schedules; checkout, start up, 
operational, functional and final acceptance test plans, procedures, checklists, and reports; and 
operation and maintenance training plans. 

PART 2 - PRODUCTS 

2.1 PRESSURE GAUGES 

A. Acceptable Manufacturers:  Marsh, Ashcroft, Weiss, Trerice, or equal. 

B. Description:  4 1/2-inch dial, molded black polypropylene turret case. 

C. Range: 
 

System Pressure (psi) Graduations (psi) 
Sprinkler Piping 0-160 1 

 

 
12/23/13 GAUGES FOR FIRE SUPPRESSION SYSTEMS 
S:\CONSULTANT MANUAL\SPEC_SAMPLE.DOC 210519-1 
 



 

PART 3 - EXECUTION 

3.1 INSTALLATION - GENERAL 

A. Provide pressure gauges where shown on the drawings. 

B. Install devices as required and as recommended by the equipment manufacturer. 

C. Extend all connections, wells, cocks, or gauges to a minimum of 1 inch beyond insulation 
thickness of the various systems. 

D. Locate instruments so that they may be conveniently read at eye level or easily viewed and read 
from the floor or from the most likely viewing area, e.g., platform, catwalk, etc. 

E. Install instruments over 6'-6" above floor, to be viewed from the floor, with face at 30 degrees 
to horizontal. 

3.2 INSTALLATION - PRESSURE GAUGES 

A. Provide instrument gauge cock at inlets. 

B. Locate pressure gauge taps for measuring pressure drop or increase across pumps, etc., as close 
to the device as possible. 

Choose 3.3 or 3.4.  Use 3.3 if Commissioning Section 019100 is included in the project manual; otherwise use 3.4. 

3.3 COMMISSIONING 

A. Commission items specified herein. 

3.4 TESTING 

A. Check out, start up, and test items specified herein. 

END OF SECTION 210519 
 

 
GAUGES FOR FIRE SUPPRESSION SYSTEMS 12/23/13 
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